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General Information

The StationManager™ software provides the User with a comprehensive predefined database for maintaining
design, operation, inspection, and compliance data associated with pressure-reducing stations. Data is
accessed through an easy-to-use spreadsheet-style interface. The spreadsheet interface is enhanced by several
complementary interface options. A pop-up Data Entry Form that allows “fill-in-the-blank” access and entry.
And a powerful pop-up Schematic Data Interface, which allows graphical viewing of data values and results,
and point-and-click access to the station data. Integral to the database is a full calculation engine for
performing capacity and pressure calculations to ensure regulatory and operational compliance.

The information contained in this guide is intended to provide an overview of the StationManager software
by demonstrating a portion of its rich, robust, and extensive feature set. Although the entire StationManager
feature set is not fully demonstrated, the features that are used during the exercise should provide a good
appreciation of how StationManager may be used to satisfy your regulator/relief valve station management
needs.

The instructions in this guide assume that the User has a working knowledge of the Windows operating
environment, is familiar with navigating Windows-based applications, and has an understanding of
regulator/relief valve stations in a natural gas application. The example in this guide demonstrates how to
create a new database, add a station, perform a calculation, and review the calculation results. Although the
tasks used in the example are not comprehensive, they represent many of the most commonly used features
of StationManager and provide a good foundation for building an understanding of its use.

The remainder of this guide will step you through the installation of StationManager and the creation and
manipulation of a simple example database. Inserted throughout the text are notes which provide additional
information about the software. The example is a bit long. Please be patient and persistent in working
through it - completing the example will provide a valuable lesson on how to utilize the software to
efficiently meet your station management needs.

System/Hardware Requirements

StationManager will operate on any device configured to Windows 8 through Windows 11.

The Demonstration version of the StationManager software will require a minimum of 49 MB of free hard
disk space when installed.
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You will need to be logged on as the Full Administrator or use the “Run as administrator” option
when executing the installation file.

Note...

On the License Agreement screen, read the Terms Of Use Agreement carefully and select the “I
agree to...” option. If you do not wish to accept the Terms Of Use Agreement, you will not be
able to continue with the installation process.

Note...

• An appropriate version of Windows must be running before StationManager may be executed.
If Windows is not running, begin its execution now.

• You will need to be logged on as the Full Administrator or use the “Run as administrator”
option the first time you execute the StationManager software.

Note...

Installing StationManager

An appropriate version of Windows must be running in order to install StationManager. If it is not, start
Windows now, then proceed with the installation process described below.

! Download the compressed folder (.zip) containing the setup executable file from our website
(www.b3pellc.com) to your device. Navigate to the downloaded file’s location and open or explore it using
Windows File Explorer.

! Double-click the setup file’s name in the compressed folder. If a Windows Security warning appears, allow
your device to execute the file.

! After the setup program has been started, several screens will be displayed during the installation process.
Read the contents of each screen carefully and respond appropriately.

! A message will be displayed when the installation process is complete. The message will indicate whether
the installation was successful or whether it failed. Select the appropriate option to clear the message.

Starting StationManager

! From the Windows Desktop select the StatMan shortcut icon.
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! The StationManager software will be started, and the Welcome screen will be displayed. Click the
Continue command button.

! The Demonstration Notes screen will be displayed. Read carefully, then click the Continue command
button. A sample StationManager database will be displayed.

Database Design

The StationManager software provides the User with a comprehensive predefined database for maintaining
design, operation, inspection, and compliance data associated with pressure-reducing stations. Data is
accessed through an easy-to-use spreadsheet-style interface. The spreadsheet interface is enhanced by several
complementary interface options.

! A pop-up Data Entry Form allows “fill-in-the-blank” access and entry.

! A powerful pop-up Schematic Data Interface allows graphical viewing of data values and results
and point-and-click access to the station data.

Integral to the database is a full calculation engine for performing capacity and pressure calculations to
ensure regulatory and operational compliance.

The StationManager database consists of a group of files containing various values associated with different
aspects of the station data. These include a file containing general database setup and default information,
a file containing general station information, a file containing the data required for the hydraulic analysis,
a file containing inspection results, and a file containing specific equipment information for the pressure
regulating and relief devices. The Station Data file contains a record for each station. Each station record is
linked to the remaining data files so that all data can be accessed based on the selected station record.
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StationManager defines a station as a collection of runs, stages, devices, and piping sections. A run consists
of one or more stages. A stage consists of one or more devices and the associated piping sections. A device
is a pressure limiting or overpressure device - regulator or relief valve. Devices are designated as upstream
(regulator) or downstream (regulator, relief valve, or security valve). The piping sections are defined as
upstream (supply or inlet), intermediate (between the upstream and downstream device), downstream (outlet
of station), and stack (outlet of relief valve).

A station can contain one or two runs. A run can contain one or two stages. A stage can contain one or two
devices. Stages can be configured as regulator only, regulator-regulator, regulator-relief valve, dual regulator-
relief valve, relief valve only, or security valve only. Operation schemes for regulator-regulator
configurations can be upstream monitoring - downstream controlling, upstream working monitor -
downstream controlling, upstream controlling - downstream monitoring, or simple first cut - second cut
without overpressure protection.

When two stages are present, the downstream section of the first (upstream) stage is disabled, and the
upstream piping of the second (downstream) stage is assumed to be connected directly to the outlet of the
first-stage downstream device.

If a stage consists of a regulator only, the downstream device is disabled. The regulator must be assigned as
the upstream device. The intermediate piping is disabled, and the downstream piping is assumed to be
connected directly to the outlet of the upstream device (regulator).

If a stage consists of a relief valve or security valve only, the upstream device is disabled. The valve must
be assigned as the downstream device. The intermediate piping is disabled, and the upstream piping is
assumed to be connected directly to the inlet of the downstream device (relief or security valve).

In addition to the station data, a set of data files referred to as “Property Tables” are also maintained. These
files contain common information about pipe, fitting, regulator, and relief valve properties. The common data
contains values such as inside pipe diameter, equivalent lengths for fittings, and valve factors for the
regulator and relief valves. The Property Tables can be customized by the User to reflect their specific needs.

Some of the supported station configurations are shown in the following figure.
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In addition to the configurations shown, relief valves can be “shared” between a parallel run and stage or
“combined” on stages in series. Sharing a relief valve refers to the case where regulators in a parallel run and
stage are protected by a single relief valve, assumed to be installed on one run or the other. Combining a
relief valve refers to the case where an upstream regulator is protected by two (different) downstream relief
valves - the capacity of the relief valves is combined during the compliance check. The combined relief
valves are assumed to be installed in series on the same run.

The device control lines are assumed to be connected as follows:

Control Line Sense Location

Configuration Device Sense Location

Regulator Only Upstream (Control) Inlet of Downstream Piping

Monitor - Upstream Upstream (Monitor) Inlet of Downstream Piping

Downstream (Control) Inlet of Downstream Piping

Monitor - Downstream Upstream (Control) Inlet of Downstream Piping

Downstream (Monitor) Inlet of Downstream Piping

Monitor - Upstream Working Upstream (Control) Inlet of Intermediate Piping

Upstream (Monitor) Inlet of Downstream Piping

Downstream (Control) Inlet of Downstream Piping

First Cut - Second Cut Upstream (Control) Inlet of Intermediate Piping

Downstream (Control) Inlet of Downstream Piping

Regulator/Relief Valve Upstream (Regulator) Inlet of Intermediate Piping

Downstream (Relief Valve) Outlet of Intermediate Piping

Relief Valve Only Downstream (Relief Valve) Outlet of Upstream Piping

Security Valve Only Downstream (Security
Valve)

Outlet of Upstream Piping
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Sample Database

A sample database is included when StationManager is installed. The database contains sample records for
some of the station configurations supported by StationManager. The database will be automatically opened
when StationManager is first executed. To open the database at other times, use the Open item from the File
menu. Instructions for browsing and manipulating the database contents are provided in the Example section
of this Demonstration Guide. If changes are made to the sample database, the original contents can be
restored using the Restore Samples item from the File menu.

Database Interface

The values contained in the database are accessed through a spreadsheet-style report. The data is grouped
by functionality into separate report sections, which are displayed on separate report tabs. The report consists
of tabs, rows, and columns. Each row represents a record, and each column represents a specific data item.
Each station is represented by a record and a set of sub-records for each run and stage.

Several options are available for viewing and entering data values and results. The primary means of access
is through the Database Report. This access option allows direct access to the data values and results and
provides a variety of data manipulation tools. The Report interface is complimented by several additional
specialized interfaces. The pop-up Data Form allows data to be entered using a fill-in-the-blank style
interface, and the results are presented in a similar style. The pop-up Schematic Data Interface provides
graphical access to the data values and results and allows point-and-click data editing and graphical display
of the calculation results.

The Station Data Report is the only access option that allows station records to be inserted or deleted.
Records can be added to the end of the database with any of the edit-enabled interfaces. The report must be
open to access the station data or any of the other data access interfaces. Tools are provided to create a
selection set or sorted set of records, limit the data displayed, to add, enter, insert, and move records, to
update values en masse based on User-defined selection criteria, and save a selected set of data.

Using The Help System

The help documents are stored on a B3PE server. You must be connected to the internet to access the various
StationManager help and support documents.

The StationManager Manual can be used for information on specific screens and commands as well as
detailed instructions, descriptions, and explanations.
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Once a document is opened, it can be saved locally if you wish. If you save a help document to your machine
for offline access, you will need to open it directly in your Portable Document Format (PDF) document
viewer. A suitable PDF document viewer or reader is required to view and print the documents.

The Help Menu

Access to the various help documents and information is provided in the Help menu. You can also view our
contact information, send a help request, or visit our website. Note - Some of the features require an internet
connection to work properly.

Contact Us

Hours - Our normal work hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However, if you have a problem, please try at any time - we may be in.

By Telephone - (719) 578-9391

By Email - help@b3pe.com

By Website - www.b3pellc.com
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Example

After browsing the sample database, use the instructions provided in the following sections to create, edit,
calculate, and report your own example database.

If a database is already open, close it now using the Close item from the File menu.

Create The Database

The first step in creating a database is to open a new set
of data files. To create a new database, from the File
menu, select the New item. The Database Selection
screen will be displayed. For the Filename, type “First”,
then click the Continue command button.

A new database containing a single station record will
be displayed as a spreadsheet-style report, the Station
Data Report. If the report was not displayed when the
new database was created, select the Station Data item
from the Report menu to display it now.

Before entering any data, the database must be “set up”
by establishing various values, such as dimensional
units and default data values.

Set The Calculation Options

When a new database is created, the check limits and
values need to be set. These values are part of the
Calculation Options. To set the values:

! From the File menu, in the Preferences
submenu, select the Set Calculation Options
item. The Calculation Options screen will be
displayed.
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! Set the following values:

Regulatory Code/Specification = US DOT Part 192
Inspection Frequency = US DOT Part 192
Atmospheric Calculation Method = AGA/Smithsonian
Failure Style For Two Stage Set = Single (Independent) Failure
Velocity Limit - Failed Conditions = 1500.00 Feet/sec
Velocity Limit - Normal Conditions = 200.00 Feet/sec
Outlet To Set Pressure Ratio Limit = 90.00

Other Options -
Limit Pipe Flow To Sonic Velocity = Select

! After all of the values have been set, click the Close command button to save the changes and
close the screen.

Set The Default Data Values

In addition to the calculation options, the default data values also need to be set. These values are used to
populate various values for the newly added or imported station records. To set the values:

! From the Utilities menu, select the Set Default Values item. The Default Data Values screen will
be displayed. The values are grouped by functional type and displayed on the various data tabs.

! On the Dimensional Units data tab, set the following values:

Coordinates = Degrees L/L
Diameter = Inches
Efficiency = Percent
Elevation = Feet
Flow Rate = Mcfh
Length = Feet
Pressure (Abs) = Psi (Abs)
Pressure (Gauge) = Psi
Temperature = Fahrenheit
Velocity = Feet/sec
Viscosity = Lbm/Ft-sec

! On the Base/Gas Properties data tab, set the following values:

Pressure = 14.73 Psi (Abs)
Temperature = 60 Fahrenheit
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Viscosity = 0.000007 Lbm/Ft-sec
Specific Gravity = 0.6
Specific Heat Ratio = 1.3

! On the Hydraulic Data tab, set the following values:

Pipe Flow Equation = IGT-Improved
Pipe Efficiency = 95 Percent
Pipe Components: Note - See the following note on Component Entry.

Upstream = P: 2S-STD - Len: 10.0
Intermediate = P: 2S-STD - Len: 1.0
Downstream = P: 2S-STD - Len: 10.0
Stack = P: 2S-STD - Len: 5.0

Station Inlet Pressure: Min = 0 Psi Max = 500 Psi
Required Flow: Min = 0 Mcfh Max = 10 Mcfh
Station Elevation = 0 Feet
Flowing Temperature = 60 Fahrenheit
Inspection For Year = Enter the current year in YYYY format.

! After all of the values have been set, click the Apply All Values command button. Click the Yes
command button when prompted to make the change, then click the OK command button when
complete.

! Click the Close command button on the Default Data Values screen to save the changes and close
the screen.
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Component Entry

• A Components list describes the pipe and fittings
associated with a piping section. For example, the
pipe segments and fittings associated with the
upstream (inlet) pipe section, the intermediate
section, the downstream (outlet) section, and the
stack piping. Each component in the list is identified
with a “P:” for a pipe segment or “F:” for a fitting,
followed by a Size/Type Code, followed by a
quantity. Multiple pipe segments and fittings can be
assigned to a Components list. A Components list is
generated using the Piping Components screen.

• To edit or create a Components list, click in the
associated Piping Components data field on the
Hydraulic Data tab of the Default Data Values
screen. The Piping Components screen will be
displayed. Add or edit the associated components.
When satisfied, click the Close command button to
exit the screen and assign the component list.

• For example, to set the Upstream Piping Component to “P: 2S-STD - Len: 10.0”:

1) Click in the box next to the Pipe Components-Upstream item. The Piping Components
screen will be displayed. Select the Components data tab, then select the Piping data tab.

2) If the Components list already contains values, click on each item and click the Delete
command button.

3) In the Segment Data section, select the value “2S-STD” from the Size/Type list. Enter
“10” for the Length, and leave the ID Number data field blank. Then click the Add
command button.

4) After the item is added to the Components list, click the Close command button to exit
the screen and assign the component.

Note...
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Accessing The Data

Before entering any data, let’s discuss how the data values are displayed and how to access the values. The
values contained in the database are accessed through a spreadsheet-style report, the Station Data Report.

The Station Data Report contains separate tabbed sections for each functional data group. For example, there
are sections for General, Hydraulic, and Compliance data. Each section contains a list of records for each
station and may contain sub-records if more than one stage or run is present.

Any item with a white background can be edited by the User. Calculated items are displayed with a yellow
cell background, unused items are displayed with a cyan background, and fixed items are displayed with a
gray background. If desired, the column widths can be adjusted.

Data values can be changed directly in the Station Data Report or using one of the complimentary entry/edit
options. The pop-up Data Entry Form or the pop-up Schematic Data Interface can be displayed by selecting
the appropriate icon from the Station Data Report icon menu. The Data Entry Form can also be displayed
by double-clicking on the Station Record number displayed on the left side of the report. Individual data
values are accessed in the report by clicking on the cell containing the desired value. When clicked, a data
entry box or data list will appear. Either click the Enter key or click in another cell to save a change, or click
the Esc key to leave the value unchanged.

The current record (highlighted record - the record that is being edited) is identified by the greater than
symbol (“>”) placed before and after the Station Record number.
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An icon menu is provided at the top of the Station Record. The icons displayed in the menu allow
access to a variety of data manipulation routines. The background of the Calculate Values For All
Stations icon will display in different colors depending on the calculation and compliance status
of the stations in the database. If all of the stations “pass” the hydraulic and compliance analysis,
the background will be “Green.” If a change has been made to the database and the results have not been
recalculated, the icon background will be “Yellow.” If at least one of the stations has failed the analysis, the
icon background will be “Red.”

The report window will display differently on different monitors; let’s resize it now so that it fits
nicely on your monitor. Select the Maximize Window Size icon to fit the window to your monitor.
Note - The report window can also be manually sized by dragging the sides or corners of the
window with the mouse.

Enter The Station Data

Once the calculation options and the default data values have been set and the Station Data Report opened
and resized, the database is ready for data entry. StationManager allows data to be entered directly into the
database report (spreadsheet-style report screen), using the Data Entry Form, or using the Schematic Data
Interface. In this example, we will use each of the methods to define portions of a station consisting of a
single run and single stage equipped with a regulator protected by a relief valve. Other station configurations
can be entered by adapting the listed steps as appropriate.

General Data - Station Data Report

We will start by entering the “General” station data directly in the Station Data Report.

! Select the General data tab. In Station Record “1”, set the following values by clicking in the
associated data cell and either type a value or select a value from the list, then click the adjacent cell.

Location Information -
District Identification = Sample
City/Town = Rimrock
State = CO
Legal Description = S21 R67W T24S
Station Identification = PRV 1
Station Description = District Reg for Subdivision
Location = NE Corner of Main & 1st
X Coordinate = 105.5230 Degrees L/L
Y Coordinate = 37.5231 Degrees L/L
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You will probably have noticed that some of the data items were already assigned values. These
values were set based on the default data that was previously entered. The default data simply
provides a way of setting redundant data values and provides an initial value for items that may
not be immediately known. As you saw, the items assigned default data values can be assigned
another value by entering the desired value.

Note...

Configuration -
Operating Status = In Service
Number Of Runs = 1
Stages Per Run = 1

Capacity -
Minimum Required = 0 Mcfh
Maximum Required = 30 Mcfh

Gas Properties -
Elevation = 6200 Feet
Flowing Temperature = 50 Fahrenheit
Base Pressure = 14.73 Psi (Abs)
Base Temperature = 60 Fahrenheit
Specific Gravity = 0.6
Viscosity = 0.000007 Lbm/Ft-sec
Specific Heat Ratio = 1.3

Miscellaneous -
In Service Date = Yesterday’s Date - MM/DD/YYYY
Jurisdiction = US DOT
Designed By = Joe Designer
Design Date = 2 Weeks Ago - MM/DD/YYYY
Entered/Revised By = Your Name
Entry/Revision Date = Today’s Date - MM/DD/YYYY
Comments/Notes = Single Cut Reg/Relief

Hydraulic Data - Data Entry Form

The Hydraulic data is subdivided into several functional groups or subsections - Upstream Piping, Upstream
Device, Intermediate Piping, Downstream Device, Downstream Piping, Relief Stack Piping, etc. Depending
on the station configuration, some subsections may not be applicable. When a subsection does not apply, the
items associated with that subsection will be disabled or hidden. For demonstration purposes, let’s enter a
portion of the Hydraulic data using the Data Entry Form and a portion using the Schematic Data Interface.
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Upstream Piping

! To display the Data Entry Form, double-click on Station Record “1.” The Station Record screen (Data
Entry Form) will be displayed.

! Select the Run 1 Stage 1 data tab, then select the Up Piping data tab. Set the following values:

Run Configuration -
Run Type = Working - 1st Cut
Stage Style = Regulator - Relief Valve

Piping Components = P: 2S-STD - Len: 10.0
Note - See the previous note on Component Entry.

Hydraulic Data -
Min Inlet Pressure = 100 Psi
Max Inlet Pressure = 225 Psi
MAOP = 250 Psi
Efficiency = 95 Percent
Flow Equation = IGT-Improved
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Device Entry

• A device (regulator or relief valve) is identified by
a Size/Type Code. The code generally consists of a
two-character manufacturer code, a model number,
a body size, and an orifice size or trim option. For
example, the code MN FG SP 2x1 50% refers to a
Mooney Controls (MN) Flowgrid (FG) with a 2" x
1" (2x1) body size and a 50% (50%) Single Port
(SP) restricted grid plate.

• A Size/Type Code can be entered by one of two
methods: either by selecting the code from the Full
List or by generating the code using the Manufacture/Model data tab on the Device Selection
screen.

• The following describes how to enter the code using the Device Selection screen.

1) On the Device Data tab, click the Size/Type Code command button. The Device Selection
screen will be displayed. On the Manufacturer/Model data tab:

• From the Manufacturer list, select Mooney Controls.

• All of the models associated with the selected Manufacturer will be displayed in the
Model list. From the Model list, select Flowgrid.

• From the Body Size list, select 2x1.

• From the Orifice Size list, select 50% SP.

• When a valid combination has been selected, the associated code(s) will be displayed
in the Size/Type Code list. Select MN FG SP 2x1 50% from the list. Click the Apply
command button to assign the code and exit the screen.

Note...

Upstream Device

! Select the Up Device data tab, then select the Device Data tab. Set the following values:

Size/Type = MN FG SP 2x1 50% Note - See the following note on Device Entry.
Set Pressure = 40 Psi
Entered Capacity Value = Unselect
Token Relief Installed = Unselect
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Intermediate Piping

! Select the Int Piping data tab. Set the following values:

Piping Components = P: 2S-STD - Len: 5.0
Note - See the previous note on Component Entry.

Hydraulic Data -
MAOP = 100 Psi
Efficiency = 95 Percent
Flow Equation = IGT-Improved

! Click the Close command button to save the changes and close the screen.

Hydraulic Data - Schematic Data Interface

We can use the Data Entry Form to enter all of the data, calculate the station, and review the results.
However, for demonstration purposes, let’s use the Schematic Data Interface to enter the remaining data. 

Downstream Device

! To open the Schematic Data Interface, click on Station Record “1,” then select the Display
Schematic Interface icon from the icon menu. The Schematic Data Interface will be displayed. 
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! To enter the Downstream Device data, place the mouse pointer near the downstream device (relief
valve) symbol. The mouse pointer will change from an arrow to a hand shape. Left-click the mouse.
The Downstream Device Settings screen will be displayed.

! On the Device data tab, set the following values:

Manufacturer = Fisher Controls
Model = 1805
Body Size = 2
Orifice Size = None (Leave Empty)
Size/Type Code = FC 1805 2

Entered Capacity Value = Unselect
Number Of Valves = 1

! On the Set Pressures data tab, set the following values:

Set Pressure = 45 Psi
Min Build-Up = 0 Psi

! Click the Close command button to save the changes and close the screen.
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Downstream Piping

! Place the mouse pointer near the downstream piping size text. The mouse pointer will change from an
arrow to a hand shape. Left-click the mouse. The Downstream Pipe Settings screen will be displayed.

! On the Components data tab, select the Piping data tab.

! In the Segment Data section, enter the Downstream Piping Components as described in
the previous Component Entry Note - P: 2S-STD - Len: 10.0.

! On the Settings/Results data tab, set the following values:

MAOP = 100 Psi Fixed = Unselect
SMYS = 0 Psi

Efficiency = 95 Percent
Flow Equation = IGT-Improved

! Click the Close command button to save the changes and close the screen.

Stack Piping

! Place the mouse pointer near the stack piping size text. The mouse pointer will change from an arrow to
a hand shape. Left-click the mouse. The Stack Pipe Settings screen will be displayed.

! On the Components data tab, select the Piping data tab.

! In the Segment Data section, enter the Stack Piping Components as described in the
previous Component Entry Note - P: 2S-STD - Len: 5.0.

! On the Fittings data tab, in the Fitting Data section, set the following values:

Size/Type = 2 Pipe Exit
Quantity = 1

! Click the Add command button to assign the associated fitting.

! On the Settings/Results data tab, set the following values:

Efficiency = 50 Percent
Flow Equation = Colebrook

! Click the Close command button to save the changes and exit the screen.
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Various other data and result values will appear in the Station Data Report and on the Data Entry
Form. These items include:

• Normal & Failed Results - These values are computed when the station is “calculated.” No data
values are entered for these data groups. We will review the various values later in the Results
section of the example.

• Inspection Data - The data contained in the Inspection group does not affect the hydraulic or
compliance analysis. We will not enter data for this group. A discussion of the items contained
in this group is provided later in this document.

• Settings & Equipment Data - The data contained in the Settings and Equipment groups are
maintained for informational purposes only. The values in these groups do not affect the
hydraulic or compliance analysis. We will not enter data values for these groups in this example.
However, if you wish to enter data for these groups, the data entry process is similar to the steps
described for the previously addressed data groups.

Note...

! Select the Close command button on the Schematic Data Interface to return to the Station Data Report.

Performing The Hydraulic & Compliance Analysis

After the data values have been entered, the hydraulic and compliance analysis can be performed. The
analysis will calculate the pressure and flow values through the station for both normal and failed conditions,
then check the results with the requirements of the selected regulatory code. The calculated values are
compared against operational and compliance standards to determine whether the station “passes” or “fails.”

! To perform the analysis:

! From the Station Data Report, select the Calculate Values For All Stations icon from
the icon menu.

! When the analysis is complete, a message will be displayed with the Calculation
Summary. Review the contents of the message, then click the OK command button to close the
message.

The station should have passed the analysis - the calculation icon should be colored “Green”.

If the station failed the analysis, the calculation icon will be “Red”. Double-check the entered values against
the values listed in the example, correct as appropriate, and then recalculate. When the station passes,
proceed with the remainder of the example.
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The displayed result values will vary depending on the outcome of the analysis (passed, failed,
or ignored). If a run is ignored or fails the analysis, a calculation message will provide a
description of the error or condition that caused the problem. Multiple problems may exist on a
run, so check the calculation message and status after each analysis to ensure that all problems
have been eliminated.

Note...

Reviewing The Results

After the analysis has been performed, the results will be displayed in the Normal Results, Failed Results,
and Compliance data tabs of the Station Data Report, on the various Run columns (Upstream Piping,
Upstream Device, etc) and on the Compliance data tab of the Data Entry Form, or displayed on the Schematic
Data Interface. Browse the results as desired.

Normal Results

To view the results associated with the normal operation of the station using the Station Data Report, select
the Normal Results data tab. The results are displayed on a run-by-run, stage-by-stage basis. If the run/stage
passes the analysis, the calculated pressure and flow values for normal operating conditions will be
displayed. If the run/stage did not pass the analysis, a message will be displayed in the rightmost column of
the report.

To view the normal hydraulic results using the Data Entry Form, select the appropriate “Run” data tab, then
click on the various section data tabs to view the associated values.

On the Schematic Data Interface, normal results are displayed in the upper (black) text.

The minimum inlet pressure and maximum flow rate are used as the basis for the normal analysis calculation.
The normal analysis assumes that any associated relief valves are closed, that any monitor regulators are
operating in “monitor” mode, and that the control device is operating normally. 

Failed Results

To view the results associated with the failed operation of the station using the Station Data Report, select
the Failed Results data tab. The results are displayed on a run-by-run, stage-by-stage basis. If the run/stage
passes the analysis, the calculated pressure and flow values for failed conditions will be displayed. If the
run/stage did not pass the analysis, a message will be displayed in the rightmost column of the report.

To view the failed hydraulic results using the Data Entry Form, select the appropriate “Run” data tab, then
click on the various section data tabs to view the associated values.
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On the Schematic Data Interface, failed results are displayed in the lower (gray) text.

The maximum inlet pressure and minimum flow rate are used as the basis for the failed analysis calculation.
The failed analysis assumes that the normal control device has failed wide-open, that any associated relief
valve is relieving, or that any monitor regulator has taken overpressure control.

Compliance Results

The detailed normal and failed results are listed with the hydraulic values as described above. The
compliance results list the overall station results and a comparison of the calculated values and the regulatory
required values and limits.

To view the compliance results using the Station Data Report, select the Compliance data tab. The results
are displayed on a station-by-station basis. If all runs and stages associated with the station passed the
analysis, the overall station passed the analysis, and the calculated pressure and flow comparisons will be
displayed. If any run or stage does not pass the analysis, the overall station will fail the analysis, and a
message will be displayed in the right-most column of the report.

To view the compliance results using the Data Entry Form, select the Compliance data tab.

To view the compliance results using the Schematic Data Interface, move the mouse pointer near the
compliance status message (upper right corner of the Station Information section). The mouse pointer will
change from an arrow to a hand shape. Click the left mouse button. The Compliance Data screen will be
displayed.

For the compliance analysis, the regulator (upstream device) capacity is calculated using the maximum inlet
pressure, and the relief valve (downstream device) capacity is calculated using the maximum allowable
downstream value (MAOP and Allowable Build-Up). The maximum calculated pressure values shown in
the compliance results are based on the values associated with the failed analysis results.

Printing The Data & Results

The StationManager Print routine allows the data and results contained in the database to be sent to a print
device. The values for a single record or for multiple records can be printed in a spreadsheet format from the
Station Data Report. The report Print routine prints in a spreadsheet-style format.

Data for individual stations can be printed when using the Data Entry Form or the Schematic Data Interface.
The data forms print in a document format. The schematic prints the graphical depiction and data in a format
similar to the format displayed on the Schematic Data Interface.
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Because of the amount of data contained in the Station Data Report, the report width will almost
always be greater than the page width. A message will be displayed stating that the report width
is greater than the page width. An option will be given to cancel the Print routine or continue.
Generally, you will want to select the continue option. If the print is continued, the report will
be printed on multiple pages.

To better fit the report on the printed page, try reducing the number of columns by
using the Set Columns icon to specify which columns to display and print. When the
icon is selected, a dialog box will be displayed. The checked column names represent
the columns that are currently displayed. Uncheck some of the columns by clicking
on the associated checkbox.

Use a proportional font like “Arial Narrow” and use a font size of 9 points or smaller. Set the
printer orientation to “Landscape.”

Note...

Printing From The Station Data Report

To print values from the Station Data Report, select the Print icon from the icon menu. The Print
Settings screen will be displayed. Enter or select the desired settings, then click the Print
command button to send the report to the printer.

Printing From The Data Entry Form Or The Schematic Data Interface

To print values from the Data Entry Form or the Schematic Data Interface, click the Print command button.
The Print Settings screen will be displayed. Enter or select the desired settings, then click the Print command
button to send the report to the printer. 

Working With The Inspection Data

The Inspection data provides a facility to document the results from station field inspections. The data
consists of a variety of common inspection items, inspection dates, required actions, and status. The status
indicates whether the station has already been inspected, has been inspected and requires additional action,
or needs to be inspected. The number of days remaining in the required inspection period will also be
calculated and displayed.

The inspection findings are set by clicking in the associated cell until the desired setting is displayed. The
value of the inspection findings does not affect the inspection status. If an item fails inspection, it should be
noted in the Required Actions data field in the Miscellaneous section. This will cause it to be noted in the
inspection status until the required action is completed.
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The Required Inspection Date and number of days left in the inspection period are calculated based on the
Previous Inspection Date, the For Year value, and the selected Regulatory Code.

A field inspection form can be printed for each station. The inspection form provides a means of
documenting the field inspection and aids in the entry of the inspection and setting data. The form can be
printed using the report Print routine. To print an inspection form:

! Select the Print icon from the icon menu at the top of the Station Data Report. The Print
Settings screen will be displayed.

• In the Include section, only select the Inspection Form item.

• To print forms for all of the stations in the current selection set (or the entire database if no
selection set is present), ensure that the Current Record Only item is not selected in the Other
Settings section. To print a form for the current record only, ensure the Current Record Only item
is selected.

• When the appropriate settings have been made, click the Print command button to print the
form(s).

What To Do Next

This simple example provided a brief overview of the basic routines and functions supported by the
StationManager software. There are many other routines and features that were not demonstrated by the
example - the Import/Export routines and the Mass Update routines are especially robust and useful. Perhaps
you may wish to explore some of these features on your own. You can refer to the help topics for more
information and further explanation of StationManager’s capabilities.

When you are done exploring the software, select the  And Return License item from the Exit menu to leave
StationManager. If the “save changes” message is displayed, select the appropriate response to save or ignore
the changes you made to the database.

Uninstalling StationManager

If, after using the StationManager software, you wish to remove it, select the Uninstall StationManager 2.1
item from the StationManager Windows Start menu list.

! After the Uninstall Program has been started, read the contents of each screen carefully and respond
appropriately.
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If the Uninstall Program asks to remove any shared system files, click the No command button.
Note...

• On some devices, the Uninstall routine will not be able to remove any directory or file that has
been created after the initial installation.

• Some of the files and/or folders created by StationManager after the installation may include
files in the initialization directory (ini), files in the default calculation file directory (files), and/or
files in the application directory (app).

• To remove these files and/or folders, use Windows File Explorer to find and delete the
remaining files and folders. An example of the path for the initialization folder is shown below.
The other folders have similar path locations.

• 32-bit machines - C:\Program Files\StatMan 2\ini
• 64-bit machines - C:\Program Files (x86)\StatMan 2\ini

Note...

! A message will be displayed when the Uninstall routine is complete. The message will indicate whether
the routine was successful or whether it failed. Select the appropriate option to clear the message.
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